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Fermilab’s logo— which includes both the historic logomark and the 
logotype “Fermilab”—serves as the core graphic identity for the 
lab. Whenever possible and practical, use the logo in its entirety as 
described and provided in this guide. 

The Fermilab logo should only be obtained directly from the download 
links on the website at http://www.fnal.gov/faw/designstandards/logo.
html. Provided are various file formats suitable for your communication 
needs (jpg, eps, png, pdf) in four color options (NAL blue, black, 
gray and white). The Fermilab logo must appear on all internal and 
external communications. To preserve and ensure its consistent 

reproduction, the logo should not be redrawn, altered or modified in 
any way. 

The logo shall not be used in any manner that falsely implies employ-
ment by, or affiliation with, Fermi National Accelerator Laboratory.  
The Fermilab logo may not be used for commercial purposes, including 
but not limited to endorsement of products or services.

For questions or comments regarding logo usage or guidelines,  
or if design assistance is needed, please contact VMS at vismedsr@
fnal.gov.

logomark logotype

Logo   
The entire logo includes the logomark combined with the logotype.
To use the logo mark without the logotype requires permission from 
Visual Media Services.

File Formats
Various logo formats and color profiles are available for download  
for your communication materials. The following are available for 
download: EPS (this is a vector file and recommended for all pro-
fessionally printed applications), JPG, PNG, PDF (these formats are 
good for web and presentation). The JPG logo file is best used  
for on-screen application. The PNG file is available with a transparent 

background, which allows for the logo to be placed on a color back-
ground or photo. The Fermilab logo is also available in the following 
color profiles: CMYK, PMS and RGB.

For questions or comments regarding logo usage or guidelines, or 
if design assistance is needed, please contact at vismedsr@fnal.gov.

NAL Blue

White

Gray 75

Black

Fermilab Logo
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DO NOT change the logo or alter in it any way. 
No part of the logo should be altered or manipulated. These  
examples illustrate a few of the unacceptable uses of the logo.

Application Examples
These are examples of how the logo might be expressed on various 
applications. These are not the only acceptable uses of the logo but 
are examples of acceptable usage. For applications when the 

Clear Space
The Fermilab logo must be surrounded by a clear space at least half 
the height of the logomark. The clear space around the logomark is 
measured from the top, right, left and bottom of the mark.

Minimum Size
To maintain full legibility, the minimum recommended reproduction 
width for the Fermilab logo is ¾ of an inch for the majority of  
communication products. 

Do not reorder the logo elements.

Do not apply a color different than  
what is available for download.

Other do not do’s:
Do not apply effects 
to the logo.

Do not crop any part  
of the logo.

Do not create your 
own co-branding or 
signature.

Do not add colors to the logo.

Department of Particle 
Physics at Fermilab

Do not add any text to the logomark.

Do not manipulate or distort the logo.

Do not substitute the logotype 
with another font.

Fermilab

Do not place the logo on a busy 
image or patterned background.

Do not alter the proportions of the 
logomark or logotype.

Fermilab Logo Usage

Do not remove the logomark.

Do not place anything in the logomark.
Do not place anything on top of the 
logomark.

logo is placed on a complicated background, the logo should be 
reversed out to white. The logo must always have a crisp contrast 
with the background color or image.

½ the height of 
the logomark 

¾ of an inch wide

¾”
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Administrative Relationships: Fermilab, DOE and FRA, LLC

Fermilab is managed by Fermi Research Alliance, LLC for the U.S. 
Department of Energy, and whenever possible and practical the 
relationship among these three organizations should be acknowledged. 
This is particularly important for public communications. 

Vertical Relationship
Repeat the first step as listed for the horizontal relationship, but for 
Step 2 for the vertical pairing, increase the size of the Fermilab logo by 
25% and left align “E” and “F.”

Fermilab and FRA Relationship
The Fermi Research Alliance, LLC logo should be used when  
materials are being developed in conjunction with activities or 
events sponsored by FRA. Please contact Visual Media Services  
at vismedsr@fnal.gov to obtain a copy of the FRA logo. 

Fermilab and the DOE
Whenever possible and practical, the Fermilab and DOE logos should 
both appear in laboratory communications, depicted at the same  
level in the document and scaled to a balanced proportion. Examples 

Step 2: Increase the size of the Fermilab logo by 20%. The two logos 
now are visually balanced. Both the “Fermilab” and “ENERGY” should 
be bottom aligned.

Increase Fermilab logo by 25%.

Increase the 
FRA logo 
by 25%.

For most applications the DOE Office of Science logo may be used. Please con-
tact Visual Media Services at vismedsr@fnal.gov if you wish to use the DOE logo.

of proper depiction of the Fermilab and DOE logos include the Fermilab 
homepage fnal.gov and the About Fermilab fact sheet. 

Horizontal Relationship
Step 1: After downloading both the logos, scale the word “Fermilab”  
and “ENERGY” to the same height. Both should be bottom aligned.

Choose one of the following sentences:

Horizontal Relationship
Step 1: Begin by making the height of the word Fermilab the same 
height as the Fermi Research Alliance, LLC logo as shown below.  
Bottom align “Fermilab” and the FRA logo. 

Step 2: Increase the size of the Fermi Research Alliance, LLC logo by 
25%. The two logos now are visually balanced. Both the “Fermilab”  
and FRA logo should be bottom aligned.

Increase the FRA 
logo by 35%.

Align the vertical centers of the logomarks.

Vertical Relationship
Repeat the first step as listed for the horizontal relationship, but 
scale the FRA logo up by 35% and align the vertical centers of  
the Fermilab and FRA logomark.

The goal is to have the Fermilab, DOE Office of Science and FRA 
logo have equal visual weight when paired together. This can be 
tricky without a trained eye. Below is a guide on how to pair the two 
logos to have a balanced relationship.

Fermilab, FRA and DOE 
Whenever possible and practical, the relationship between Fermilab 
and Fermi Research Alliance, LLC should be indicated by including  
one of the following sentences provided on the right.

This sentence should be located below the Fermilab logo, and  
the DOE logo if used. Examples of proper inclusion of this  
sentence include the Fermilab letterhead and memo templates. 

Managed by Fermi Research Alliance, LLC for the  
U.S. Department of Energy

Managed by Fermi Research Alliance, LLC for the  
U.S. Department of Energy Office of Science 

Increase Fermilab logo by 20%.
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Sub-units of Fermilab (divisions, sections, centers, offices,  
organizations) that have a need for their own logo may request  
a Fermilab co-branded logo from Visual Media Services. 
Logos are available in various file formats (EPS, JPG, PDF, PNG) 
and various color profiles (CMYK, RGB, PMS) in NAL blue, black, gray 
or white. To request a co-branded logo, please contact VMS at  
vismedsr@fnal.gov.

Co-Branding 

Minimum Size
To maintain full legibility, the minimum recommended reproduction 
width for the Fermilab co-branded logo is 1.75 inches in width for  
the majority of communication products. 

Co-Branded Logo Examples

Workforce Development 
& Resources Section

IARC Illinois Accelerator 
Research Center 

Office of Communication 

IARC Illinois Accelerator 
Research Center

Office of Communication 

Office of Integrated 
Planning & Performance  
Management

1.75”

Workforce Development 
& Resources Section
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Fonts

Typefaces play an important role in identifying the Fermilab brand.  
For in-house communication we recommend the use of Helvetica and 
Palatino as the primary typefaces. Consider these font choices as 
guidelines and suggestions, rather than as restrictions. Substituting 
fonts is acceptable in internal communications if the primary type-
faces are not available. When choosing your font, the overall goal 
should be consistency, legibility and readability. 

Primary Typefaces Substitute Typefaces

Fonts for Fermilab Staff 
This set of fonts are intended for day-to-day use—correspondence, 
memos and all in-house communication. Recommended are a set  
of primary typefaces (Helvetica and Palatino) and substitute typefaces 
(Arial and Times New Roman). The substitute selection should be 

Helvetica Regular
a b c d e f g h i j k l m n o p q r s t u v w x y z
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
0 1 2 3 4 5 6 7 8 9

Helvetica Bold
a b c d e f g h i j k l m n o p q r s t u v w x y z
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
0 1 2 3 4 5 6 7 8 9

Sans Serif 
Helvetica is recommended for use  
on displays, posters, headlines, titles, 
chart figures, signage, letterheads 
and memos. When appropriate, 
use Heveltica Regular for body text. 
Arial is the recommended substitute 
typeface.

Serif 
Palatino is recommended for body 
text. It was chosen to complement 
Helvetica and enhance readability. 
Times New Roman is the recom-
mended substitute typeface.

Palatino Linotype Regular (or Palatino)
a b c d e f g h i j k l m n o p q r s t u v w x y z
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
0 1 2 3 4 5 6 7 8 9

Times New Roman Regular
a b c d e f g h i j k l m n o p q r s t u v w x y z
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
0 1 2 3 4 5 6 7 8 9

Arial Regular
a b c d e f g h i j k l m n o p q r s t u v w x y z
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
0 1 2 3 4 5 6 7 8 9

Arial Bold
a b c d e f g h i j k l m n o p q r s t u v w x y z
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
0 1 2 3 4 5 6 7 8 9

Sans Serif Typeface: Helvetica Neue Serif Typeface: Adobe Garamond

Fonts for Graphic Designers
This set of fonts are intended for use by graphic designers when 
typesetting external and key internal publications. Substitutions  
 

Helvetica Neue 55 Roman
a b c d e f g h i j k l m n o p q r s t u v w x y z
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
0 1 2 3 4 5 6 7 8 9

Helvetica Neue 75 Bold
a b c d e f g h i j k l m n o p q r s t u v w x y z
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
0 1 2 3 4 5 6 7 8 9

Adobe Garamond is recommended for 
use in lengthy publication text settings. 
 
Helvetica Neue 55 Roman can also  
be used for body text. Italic in both 
bold and regular weights can be used 
sparingly for emphasis only.

Adobe Garamond Bold can also be 
used for headlines, subheads and titles, 
when appropriate.

Adobe Garamond
a b c d e f g h i j k l m n o p q r s t u v w x y z
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
0 1 2 3 4 5 6 7 8 9  (Use oldstyle figures)

Adobe Garamond
a b c d e f g h i j k l m n o p q r s t u v w x y z
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
0 1 2 3 4 5 6 7 8 9  (Use oldstyle figures)

For print and electronic communication products created by graphic 
designers, the recommended typefaces are Helvetica Neue and  
Adobe Garamond in the weights described below. Substitutions are 
only permitted with prior approval from Visual Media Services. 

For questions or comments regarding the font selection, guide-
line, or if design assistance is needed, please contact VMS at  
vismedsr@fnal.gov.

used only if the primary typefaces are not available on your computer. 
Although not shown in the example below, italic in both bold and 
regular weights can be used sparingly for emphasis only.

are only permitted with prior approval from Visual Media Services. 
For design assistance, please contact VMS at vismedsr@fnal.gov.
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Typography Examples for In-House Communication

These are a few examples of how the serif and sans serif typefaces  
can be used with example type sizes. Combining a primary type-
face with a substitute typeface is allowed if you do not have all the 
primary fonts installed on your computer. When choosing your font 

Combinations To Avoid
We discourage using a combination 
of sans serif typefaces, for example 
Helvetica for the Headline with Arial 
as body text, and the combination 
of serif typefaces, for example 
Palatino for the headline and Times 
New Roman for the body text.

Recommended 
Type  
Combinations 

Substitute Type  
Combinations 

Other Possible 
Type  
Combinations  

Helvetica Bold for Headlines 10pt Bold

Palatino (Linotype) in regular weight for body text. 10pt Regular

Caborem fugitatio. Nam si dolorem reptustiis mi, nust, ate prest, torrovit velesti occumquam 
init, nobis quia volut fuga. Nemoluptam voluptium none cuptatet evenis doluptatio
init, nobis quia volut fuga. Nemoluptam voluptium none cuptatet evenis doluptatio quaspis 

Helvetica Bold for Headlines 14pt Bold

Helvetica Regular can be used for body text. 10pt Regular

Caborem fugitatio. Nam si dolorem reptustiis mi, nust, ate prest, torrovit velesti occumquam 
init, nobis quia volut fuga. Nemoluptam voluptium none cuptatet evenis doluptatio quaspis dis. 
Ehendebi taquiae et omnisitatem faccuptamus sequi omni voluptatio conseni stius.

Helvetica should not be used with Arial  
Arial should not be used with Helvetica.

Palatino should not be used with Times New Roman
Times New Roman should not be used with Palatino. 

Helvetica Bold for Headlines 10pt Bold

Times New Roman in regular weight for body text. 10pt Regular

Caborem fugitatio. Nam si dolorem reptustiis mi, nust, ate prest, torrovit velesti occumquam init, 
nobis quia volut fuga. Nemoluptam voluptium none cuptatet evenis doluptatio quaspis dis es aute
init, nobis quia volut fuga. Nemoluptam voluptium none cuptatet evenis doluptatio

Arial Bold for Headlines 13pt Bold

Palatino (Linotype) in regular weight for body text. 12pt Regular

Caborem fugitatio. Nam si dolorem reptustiis mi, nust, ate prest, torrovit velesti 
occumquam init, nobis quia volut fuga. Nemoluptam voluptium none cuptatet
 

Arial Bold for Headlines 12pt Bold

Times New Roman in regular weight for body text.10pt Regular

Caborem fugitatio. Nam si dolorem reptustiis mi, nust, ate prest, torrovit velesti occumquam init, 
nobis quia volut fuga. Nemoluptam voluptium none cuptatet evenis doluptatio quaspis dis es
init, nobis quia volut fuga. Nemoluptam voluptium none cuptatet evenis doluptatio

Arial Bold for Headlines 11pt Bold

Arial Regular can be used for body text. 10pt Regular

Caborem fugitatio. Nam si dolorem reptustiis mi, nust, ate prest, torrovit velesti occumquam 
init, nobis quia volut fuga. Nemoluptam voluptium none cuptatet evenis doluptatio quaspis 
dis es autaque latium autasi omni nes simagnihil int, ilibea cus persped qui con repudamus.

combinations, the overall goal should be consistency, legibility and 
readability. Avoid using many different typefaces in your communi-
cation materials.
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RGB: 0, 0, 0
Hex: #000000
CMYK: 75, 68, 67, 90

Fermilab’s core color is NAL Blue, developed for Fermilab in the 1970s 
by the Rustoleum® paint company. The laboratory’s original color 
palette was developed using a selection of off-the-shelf paint colors 
used for tractors and farm equipment. The palette was meant to 
reference the farms that previously occupied the land. The current palette 
reflects this heritage, maintaining several original core colors while 
providing a range of tints and shades that reflect modern design needs 
and sensibilities.

The color palette is one of the most important recognition factors of 
the Fermilab brand. Use of color outside of the palette is strongly 
discouraged in print and electronic graphic applications that are 
intended to carry the Fermilab brand, messages and mission. 
Shown below are seven signature colors (featured in the center 

RGB: 0, 76, 151
Hex: #004C97
CMYK: 100, 53, 2, 16
PMS: 2945C 2945U

RGB: 65, 182, 230
Hex: #41B6E6
CMYK: 67, 2, 0, 0
PMS: 298C 298U

RGB: 0, 40, 85
Hex: #002855
CMYK: 100, 69, 8, 54
PMS: 295C, 295U 

RGB: 153, 214, 234 
Hex: #99D6EA
CMYK: 34, 0, 5, 0
PMS: 2975C, 2975U

RGB: 0, 181, 226  
Hex: #00B5E2
CMYK: 75, 0, 5, 0
PMS: 306C, 306U

RGB: 0, 133, 173 
Hex: #0085AD
CMYK:  93, 4, 8, 24
PMS: 7704C, 7704U

RGB: 120, 190, 32 
Hex: #78BE20
CMYK: 65, 0, 100, 0
PMS: 368C, 367U

RGB: 76, 140, 43 
Hex: #4C8C2B
CMYK: 76, 3, 100, 18
PMS: 363C, 369U

RGB: 54, 87, 59 
Hex: #36573B
CMYK: 59, 0, 69, 75
PMS: 7735C, 7483U

RGB: 175, 39, 47 
Hex: #AF272F
CMYK: 5, 96, 80, 22
PMS: 1805C, 1805U

RGB: 138, 42, 43 
Hex: #8A2A2B
CMYK: 0, 97, 87, 53
PMS: 7623C, 7623U

RGB: 100, 51, 53 
Hex: #643335
CMYK: 30, 85, 59, 70
PMS: 1817C, 1817U

RGB: 246, 141, 46 
Hex: #F68D2E
CMYK: 0, 54, 87, 0
PMS: 715C, 130U

RGB: 203, 96, 21 
Hex: #CB6015
CMYK: 1, 72,100, 7
PMS: 159C, 159U

RGB: 185, 71, 0
Hex: #B94700
CMYK: 2, 77, 100, 9
PMS: 1525C, 1525U

RGB: 245, 225, 164 
Hex: #F5E1A4
CMYK: 0, 4, 27, 0 
PMS: 7401C, 127U

RGB: 254, 209, 65 
Hex: #FED141
CMYK: 0, 11, 80, 0
PMS: 122C, 7404U

RGB: 234, 170, 0 
Hex: #EAAA00
CMYK: 0, 30, 100, 0
PMS: 124C, 7406U

RGB: 167, 168, 170
Hex: #A7A8AA
CMYK: 0, 0, 0, 45

RGB: 99, 102, 106
Hex: #63666A
CMYK: 0, 0, 0, 75

Primary

Secondary

Tint Signature Colors Shade

Tint Color Shade

panel) with the corresponding tints and shades displayed on either 
side. The secondary palette is intended to complement the primary 
color. When choosing colors to use, it is recommended to avoid 
mixing signature colors with other secondary tints and shades.
The appropriate color is based on the Pantone Color Standard. 
For matching, please refer to the current editions of the Pantone Color 
Publications. Each Pantone Color (PMS) listed below is followed  
by a C, for print on coated substrates, or a U, for print on uncoated 
substrates. Since substrates and processes can affect color, the CMYK, 
RGB and hex equivalents are guidelines only and should not be 
considered exact matches. NOTE: The swatches on this page are 
shown in the RGB equivalent color and are subject to differences in 
individual screen color.

NAL Blue Light

Marlin Blue Light

NAL Green Light

Massey Ferguson Red Light

Orange Light

Prairie Gold Light

Gray 45

NAL Blue 

Marlin Blue

NAL Green

Massey Ferguson Red

Orange

Prairie Gold

Gray 75

NAL Blue Dark

Marlin Blue Dark

NAL Green Dark

Massey Ferguson Red Dark

Orange Dark

Prairie Gold Dark

Rich Black

Fermilab Color Palette
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The bar element can be used in addition to the logo. There are two 
different bar thicknesses that can be used. Below are guidelines to 
determine the size of the bar when using with the logo.

The space between the bar and the logomark should be 
the same width between the logomark and logotype.

This example is on the business cards.

Option 2: Thick Bar
The height of the bar is determined by the height of the top and bottom 
horizontal strokes in the logomark.

The space between the bar and the logomark should be 
the same width between the logomark and logotype.

This example is on the PowerPoint  
and Keynote template files.

Option 1: Thin Bar
The height of the bar is determined by the height of the two inside 
horizontal strokes in the logomark.

Fermilab Bar Element
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Notes
We strongly encourage using the options available in this guide. We 
discourage adding quotations or philosophical statements to your 
email signature. Photographic backgrounds in emails or additional 
logos or image files in the email signature often make correspondence 
difficult to read and are not always compatible with other email 
programs. When these extra image files are included in your signature, 
they are added as attachments to each email you send. 
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Name O. Person 
Person’s Title

Person’s Department (optional)
Fermi National Accelerator Laboratory
P.O. Box 500, MS xxx
Batavia, Illinois 60510
USA

xxx xxx xxxx office
xxx xxx xxxx  mobile
www.fnal.gov
person@fnal.gov

Connect with Fermilab
Facebook  |  Twitter

Name O. Person  
Person’s Title

Person’s Department (optional)
Fermi National Accelerator Laboratory
xxx xxx xxxx office
www.fnal.gov

Connect with Fermilab
Facebook  |  Twitter

 Graphic Standards   Fermi National Accelerator Laboratory  2014

An email signature has been created following similar conventions 
and styles as the business card and other communication materials.  
It is recommended to use one of the following email signature options 
below. Using a standard, consistent and clean email signature will 
present a more professional appearance. Consider your email 
signature your digital business card and include the appropriate 
information. 

This guide shows a variety of signatures with many optional fields 
suitable for your specific needs. Items that should be included in 
your signature are the following: your name, your title, full lab name 

Simple Signature Options

Full Signature Options

Helpful Sites
Outlook
http://office.microsoft.com/en-us/outlook-help/create-and-add-an-
e-mail-message-signature-HA010102351.aspx

Mail (mac) Setting up a signature
http://email.about.com/od/macosxmailtips/qt/et062005.htm

Email Signatures

1. Simple Signature (with social media links)

1. Full Signature (with social media links)

3. Simple Signature (very basic)

2. Simple Signature (no social media links)

2. Full Signature (no social medial links)

Bold 

Bold 

The address  
is optional. If you 
choose to go  
without the address, 
move the phone 
numbers up under 
the lab name, like  
in simple option 2.

Italic / Regular

Add hyperlink.

Regular / 
Add hyperlink.

Regular 

Vertical line / Regular  
(2 spaces before and after)

Name O. Person  
Person’s Title
 
Fermi National Accelerator Laboratory
www.fnal.gov
person@fnal.gov (optional)

Space

Name O. Person 
Person’s Title

Person’s Department (optional) 
Fermi National Accelerator Laboratory
P.O. Box 500, MS xxx
Batavia, Illinois 60510
USA 

xxx xxx xxxx office 
xxx xxx xxxx  mobile
www.fnal.gov  
person@fnal.gov

Space

Space

Space

Space

Space

Space

Space

Name O. Person 
Person’s Title

Person’s Department (optional) 
Fermi National Accelerator Laboratory
xxx xxx xxxx office
www.fnal.gov  
person@fnal.gov (optional)

Space

and a contact (phone, email, or lab website). Some examples below 
show two lines for phone, this is optional if one number is preferred.  
If a fax number is required, it can be added below the phone numbers. 
Email is optional for the simple signature options.

The recommended typefaces to use are Helvetica or Arial. The  
signature should be set to 12pt type size. Various weights are used 
in the signature, see below for the appropriate weight that should  
be applied to each text element.

The two colors used in the email signature are NAL Blue (RGB 
0,76,151) and Gray (RGB 99,102,106). 
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Available for download is a TextEdit document (.rtf file) that contains  
a variety of signature styles. To ensure a correctly formatted email 

1) Opening the Rich Text Format file
Most computers at Fermilab will open an .rtf file using Microsoft
Word. If using Word, please be sure to compare your final sig-
nature carefully with the email signatures provided in the .rtf file. 
If Word has introduced additional vertical spacing or any
other formatting errors, we suggest deleting the signature and 
starting the process over, beginning by opening the .rtf file in 
Word (PC) or TextEdit (Mac).

2) Locate the signature area in your email browser
Using Outlook on a PC, choose File > Options > Mail > Signatures 

3) Copying the email signature
From the .rtf file, copy the signature style you prefer.

Helpful sites for adding links
Microsoft

http://office.microsoft.com/en-us/outlook-help/add-a-return-e-mail-
address-link-to-a-message-HA010156274.aspx 

http://www.ehow.com/how_5704195_set-up-hyperlink-email-signa-
ture.html

Mac mail
http://email.about.com/od/macosxmailtips/qt/et_sig_link.htm

Formatting the Email Signature

This is an 
example from  
the .rtf file.
Highlight and  
copy the  
signature for 
pasting. 

signature, follow the steps provided below. If assistance is needed, 
please contact VMS at vismedsr@fnal.gov. 

4) Pasting the email signature 
In your email browser, paste the signature copied from the .rtf file. 
The example below is from Outlook. Your email browser may dif-
fer depending on your email program and operating system. Please 
refer to the helpful links provided in this guide for more information. 

After pasting, remember to personalize your information (i.e. your 
name, department, phone numbers, and email address).

5) Adding links to the email signature
A few of the signature options provided include hyperlinks to the 
Fermilab website (www.fnal.gov), email address (person@fnal.gov), 
and social media links (Facebook | Twitter). After pasting in your new 
email signature and personalizing your information, be sure to check 
those fields to ensure that hyperlinks are present and that they point 
to the correct URL or email address. It is encouraged to test the 
hyperlinks before using the signature.

Using Outlook on a PC, you can add, view and edit hyperlinks by 
clicking on the icon showing a globe with a chain under it. For other 
email clients, please consult the Help menu or the help links provided.

Signatures

Mail 

Using Outlook on a Mac, choose Outlook > Preferences > Signatures 

For other mail clients, please consult the Help menu. Additional help 
links are provided at the end of this guide for Outlook or Mac mail.

Click this icon 
to view and edit 
hyperlinks. 
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Letterhead

 

Fermi National Accelerator Laboratory / Kirk and Pine Street / P.O. Box 500 / Batavia, IL 60510 / 630.840.3000 / www.fnal.gov / fermilab@fnal.gov 
Managed by Fermi Research Alliance, LLC for the U.S. Department of Energy Office of Science 

 Date Here 
Name Here 
Address Line 1 
Address Line 2 
City, State Zip 

Dear Name, 

Text of your letter here. 

 
 

Sincerely, 
 
 
 
 
Your Name Here 
Your Title 
 
 
cc: First cc here 
 
 

Your Name Here 
Your Department 
Your Division/Section 
630.840.your extension here 
630.840.fax, pager or mobile 

yourname@fnal.gov 

Palatino 10 pt type is recommended 
for use here. Times New Roman 
is the recommended substitute 
typeface.

The footer should not be 
moved or altered.

The logo should not be 
moved or altered.

Helvetica 7pt type is recom-
mended for this section. Arial 
is the recommended substitute 
typeface.
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Characters 
should not 
extend past 
this line.

Phone and 
email should 
not extend 
past this line.

The blue highlighted 
areas indicate text to 
be personalized.

The non-highlighted 
areas should not be 
altered or modified.

Short Version

www.fnal.gov
Name O. Person
Person’s Title

Fermi National Accelerator Laboratory
P.O. Box 500, MS XXX
Batavia, Illinois 60510
USA

XXX XXX XXXX office
XXX XXX XXXX mobile
person@fnal.gov  

Business Card Template

  Fermi National Accelerator Laboratory  Business Card Template       2014
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Long Version

The blue highlighted 
areas indicate text to 
be personalized.

The non-highlighted 
areas should not be 
altered or modified.

www.fnal.gov
Name O. Person
Person’s Title

Person’s Department
Fermi National Accelerator Laboratory
P.O. Box 500, MS XXX
Batavia, Illinois 60510 
USA

XXX XXX XXXX office
XXX XXX XXXX mobile
XXX XXX XXXX fax
person@fnal.gov

Characters 
should not 
extend past 
this line.

Four lines of personal 
contact info. 

No additional lines 
should be added. 

This section allows  
for flexibility. For  
example, one could 
have the following:
office
mobile
email
email Phone and 

email should 
not extend 
past this line.

Person’s Department 
is optional.

Business Card Template

  Fermi National Accelerator Laboratory  Business Card Template       2014
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PowerPoint Template File
A Fermilab PowerPoint template has been created based on  
Fermilab’s brand and identity. This template file is available  
to install and save on your computer for use on all future  
Fermilab presentations. This file offers a clean layout, clear  
typography and appropriate color choices.

The template file is available only in the standard 4:3 format.

Powerpoint Guidelines
This guideline provides information on installing the template 
file, opening the file to begin creating your PowerPoint, selecting  
slide layouts, and a brief style guide on the header and footer, 
colors, and fonts. The examples in this guide are screenshots from 
PowerPoint 2010 (and few from 2007) on a Windows XP or Win-
dows 7 operating system. Keep in mind that PowerPoint will 
have a different interface and layout depending on your operating 
system and software version of Microsoft Office. 

File name:  
FermilabTemplate

Save as type:  PowerPoint Template.pot  
or PowerPoint Template (.potx)

Folder: PowerPoint automatically 
chooses the correct folder for you when 
you choose to save as a Template file 
(.pot) or (.potx).

FermilabTemplate

Windows 7 / PowerPoint 2010

1. Click the File (PPT 2010) or Office Button (PPT 2007) and 
click Save As. 
  
 
 
 
 
 
 

2. In the Save as type list box, choose PowerPoint Template 
(.pot) or (.potx) 
•	 PowerPoint automatically chooses the correct folder 

when you choose to save as a Template(.pot). Accept 
the folder it suggests. Write down the full path to the 
folder; you may need it later.

•	 These are the correct folders and file path:
Windows 7 or Windows Vista 
C:\Users\UserName\AppData\Roaming\Microsoft\ 
Templates 
Windows XP 
C:\Documents and Settings\UserName\Application 
Data\Microsoft\Templates
 
If you are not taken to one of these folders, navigate there 
manually. Substitute UserName with your user name.

3. Name the template FermilabTemplate
4. Click Save and Close the program

Installing Fermilab PowerPoint template on your computer

Installing Fermilab's PowerPoint Template File (PC) 

  Fermi National Accelerator Laboratory  PowerPoint Guideline (PC)            2014
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Opening the Fermilab Template file 
To open the template file that has just been installed, reopen 
PowerPoint. Opening the Fermilab template file will vary depend-
ing on the version of operating system and particular set up of 
the machine being worked on. 

In PowerPoint 2010 Windows 7, click on File and select  
New and select My Templates.

Click File.

Click My templates.

Click New.

The template is designed in Standard (4:3) format.

PowerPoint 2010 Windows 7

Helpful sites
http://office.microsoft.com/en-us/power-
point-help/apply-a-template-to-your-pre-
sentation-HA010338385.aspx?CTT=5&orig-
in=HA010338384

Opening the Fermilab Template File

  Fermi National Accelerator Laboratory  PowerPoint Guideline (PC)            2014
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1. Click Home. 

2. Click the small triangle    
to the right of "new slide"  
to insert new slides. 
 
 
 

1. Click Home. 

2. Click the small triangle    
to the right of “new slide”  
to insert new slides. 
 
 
 

Selecting the Fermilab Slide Layouts
To insert a new slide using Fermilab’s slide layout design, locate 
the New Slide tab in your version of PowerPoint. Thumbnails 
showing a variety of slide layouts should appear. 

Selecting Fermilab Slide Layouts

Selecting Fermilab Slide Layouts  
in PowerPoint 2010 Windows 7 

Selecting Fermilab Slide Layouts  
in PowerPoint 2007 Windows XP

The Insert new slide toggle and Slide Layouts tab will be in  
different locations depending on the version of operating  
system and particular set up of the machine being worked on. 

Helpful site
http://office.microsoft.com/
en-us/powerpoint-help/add-
a-new-slide-HA001230231.
aspx?CTT=1

  Fermi National Accelerator Laboratory  PowerPoint Guideline (PC)            2014
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The following are sample slide layouts available for use when 
building your own PowerPoint presentation:
Title slide
Title with Header Line and Footer
No title, Footer only (3 slide layouts)
Title without Line with Footer 

Sample Slide Layouts

Note, PowerPoint may display the slide layouts in reverse order 
than what is shown in the example below.

For design consistency, it is recommened that when creating 
your presentation you use the slide layouts containing Title with 
Header Line and Footer. When appropriate use (sparingly) the 
other slide layout options. 

Title Slide Title & Content Content & Caption 

Footer Only: Blank Footer Only: ComparisonFooter Only: Picture & Caption

Footer Only: Title & Content

Picture & CaptionTwo Content & Caption

  Fermi National Accelerator Laboratory  PowerPoint Guideline (PC)            2014
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Header and Footer

The header and footer has been designed to maintain consistency 
in Fermilab’s brand and identity. 

The type size for the header title is 24pt. The type size for the footer 
information is 9pt in a regular weight. The “Presenter Name” and 
“Presentation Title” are separated by a vertical line element. 

The recommended primary typeface is Helvetica and the alternate 
typeface is Arial. 

Slide number

24pt type size

Date: fixed date or auto update 
(this can be selected in the 
Header and Footer settings on 
page 6).

A vertical line element separates 
“Presenter” and “Presentation Title.” 
A single space before and after the 
vertical line is recommended. 

The light blue line with the  
Fermilab Logo is a footer design 
placed into the background and 
cannot be modified.

The light blue line is part of the 
background slide design and 
cannot be modified. The title 
of the slide should always be 
placed above the line.

There is an alternate slide 
layout available named Title 
without Line with Footer.
The title size should remain at 
24pt type even without the title 
line element.

Header

Footer

  Fermi National Accelerator Laboratory  PowerPoint Guideline (PC)            2014
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Step 2.  The Header and Footer window will appear.  
Click on the fields to change the footer information.

The following are steps to edit the Footer text that appears at  
the bottom of each slide. 

Editing the Footer

Date  
2 options: update automatically 
or fixed.

Slide number
Footer
Type your name in place of  

“Presenter” and type in your 
presentation title. A vertical line 
separates the name and title. 
Leave a space before and after 
the vertical line.

Don’t show on title slide
Check this box.

Apply to all
(if desired)

Step 1.  Click on any content slide, click Insert and  
Header and Footer... 

Another way to open the Header and Footer window 
is to click View and then Header and Footer... 

Select any 
content slide to 
edit the footer,  it 
will not work if 
the title slide is 
selected.

Footer

  Fermi National Accelerator Laboratory  PowerPoint Guideline (PC)            2014
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A Fermilab color palette has been created and should be used when 
creating your PowerPoint presentation.

The Fermilab colors may appear in the first row under Theme Colors 
in your PowerPoint presentation. To see this, highlight the text  
to change color, click on the Font Color tab (step 1) and click More 
Colors (step 2). A new Colors window will open with the Fermilab 
palette (step 3).

If the Fermilab colors do not appear, click on the RGB/CMYK 
slider and enter the color formulas provided on the right.

Colors

1. Font Color tab

Clicking on this tab will 
reveal the RGB or 
CMYK sliders.

3. Colors window

The Fermilab colors may appear in the first row  
under Theme Colors, if this is not the case, use  
the RGB/CMYK slider window to enter the RGB  
or CMYK values for the Fermilab colors.

2. Click More Colors  
 if Fermilab’s Colors  
 do not appear in  
 the first row under  
 Theme Colors.

Fermilab Colors 
may appear here.

RGB or CMYK 

Fermilab Colors may 
appear here under 
Theme Colors and 
should be the same 
color swatches as 
what’s shown above.

PowerPoint 2011 

A color theme file (Fermilab.xml) is available to copy 
onto your harddrive.

Windows 7 save Fermilab.xml file in: 
%USERPROFILE%\AppData\Roaming\Microsoft\
Templates\Document Themes\Theme Colors

Windows XP save Fermilab.xml file in: 
C:\Documents and Settings\UserName\Application 
Data\Microsoft\Templates

Note, the folder location may differ depending on 
the version of windows and particular set up of the 
machine being worked on.
 
If you can not access My Themes folder on your com-
puter, the other option is to enter the color formulas.

Theme Colors

Recommended for text Accent colors, use sparingly

RGB: 153,214,234
CMYK: 34,0,5,0

RGB: 175,39,47 
CMYK: 5,96,80,22

RGB: 0,181,226 
CMYK: 75,0,5,,0

RGB: 76,140,43 
CMYK: 76,3,100,18

RGB: 246,141,46 
CMYK: 0,54,87,0

RGB: 167,168,170 
CMYK: 0,0,0,45

Blue (text and bold titles) 
RGB: 0,76,151 / CMYK: 100,53,2,16

Dark Gray (text)  
RGB: 99,102,106 / CMYK: 0,0,0,75
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Helvetica 32 pt 
(alternate: Arial Bold)

Helvetica 20 pt 
(alternate: Arial)

Title slide

This section provides the recommended font sizes and weights to 
be used in your PowerPoint presentation. 

Helvetica is Fermilab’s sans serif typeface. This PowerPoint template 
has been created with Helvetica. If Helvetica is not an option, Arial 
is the replacement font.

Fonts

Helvetica 24 pt 

Helvetica 22 pt 
Helvetica 20 pt 

Helvetica 9 pt 
(Regular weight)

Helvetica 18 pt 

Helvetica 24 pt 
(Bold) 

All other content slides

Font Sizes 
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PowerPoint Template File
A Fermilab PowerPoint template has been created based on 
Fermilab’s brand and identity. This template file is available  
to install and save on your computer for use on all future  
Fermilab presentations. This file offers a clean layout, clear  
typography and appropriate color choices.

The template file is available only in the standard 4:3 format.

Save As: FermilabTemplate (.pot) or (.potx)

Format: PowerPoint 97–2004 Template (.pot)  
or PowerPoint Template (.potx)

Folder: My Templates (this should change 
by default after (.pot) or (.potx) has been 
selected.

Installing Fermilab PowerPoint template on your computer
1. Open the file in PowerPoint. Select Save As. In the Save As 

window, change the file name to: FermilabTemplate. 
2. Click Format and choose PowerPoint 97–2004 Template 

(.pot), or PowerPoint Template (.potx) if you have a 2007 
version or newer. Click Save. 
 
After selecting the (.pot) or (.potx) in the Format field, your 
computer will by default go to the folder called My Tem-
plates.  
 
The file path to the My Templates folder on your computer 
will vary depending on the version of your software and  
operating system. An example file path of where your file 
will be saved can look something like this: 
 
Mac OSX: Users/username/Library/Application Support/ 
Microsoft/Office/User Templates/My Templates.  

3. After saving, close and quit PowerPoint. 
 
Installing the template file does not need to be repeated 
unless the file has been deleted from your hard drive. When 
saved in the My Templates folder as a (.pot) or (.potx), your 
template file will be built into your PowerPoint program. 
 
Next: Opening the Fermilab Template file to begin working 
on your PowerPoint presentation.

Powerpoint Guidelines
This guideline provides information on installing the template file, 
opening the file to begin creating your PowerPoint, selecting  
slide layouts, and a brief style guide on the header and footer, 
colors, and fonts. The examples in this guide are screenshots from 
PowerPoint 2011 and 2008 on a Mac computer. Keep in mind  
that PowerPoint will have a different interface and layout depending 
on your operating system and software version of Microsoft Office. 

Helpful site:
http://office.microsoft.com/en-us/mac-word-help/create-and-use-
your-own-template-HA102929444.aspx#BMpp

Installing Fermilab’s PowerPoint Template File (Mac)
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Opening the Fermilab Template file 
To open the template file that has just been installed, reopen  
PowerPoint. Opening the Fermilab template file will vary depending 
on the version of operating system and particular set up of the 
machine being worked on. In PowerPoint 2011, a gallery window 
may appear upon opening the program, and the template can  
be easily selected from here.  

PowerPoint 2011

PowerPoint 2008

1. Click the Gallery icon.  

Leave blank.

Leave blank or choose Arial; Arial. 

The template is designed in  
Standard (4:3) format.

Colors and Fonts are 
explained in more detail 
on pages 7-8.

Fermilab PowerPoint Template file 
should appear in the gallery here.

This is another way to open the 
template file in 2011 version.

If you have an older version or the gallery window does not  
appear, click on File and select Project Gallery (version 2008)  
or File and select New from Template (version 2011).

The examples below show how to open your template file within 
PowerPoint using the Gallery feature.

2. Click Browse... to find the 
Fermilab Template file.

Opening the Fermilab Template File
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1. Click the small triangle    
to insert new slides. 
 
 
 

2. Select from the various  
Fermilab template slide 
layouts. 

Selecting Fermilab Slide Layouts  
in PowerPoint 2011 

Selecting the Fermilab Slide Layouts
To insert a new slide using Fermilab’s slide layout design, locate 
the Slide Layouts tab in your version of PowerPoint. Thumbnails 
showing a variety of slide layouts should appear. 

Selecting Fermilab Slide Layouts

1. Click on the Slide 
Layouts tab to reveal 
layout options.

Selecting Fermilab Slide Layouts 
in PowerPoint 2008 

The Insert new slide toggle and Slide Layouts tab will be in  
different locations depending on the version of operating system 
and particular set up of the machine being worked on.

2. Click on the toggle next 
to Insert new slide. 
This will allow you to 
choose from the various 
Fermilab template slide 
layouts.

Helpful site
http://office.microsoft.com/en-
us/mac-powerpoint-help/basic-
tasks-in-powerpoint-for-mac-
HA102928448.aspx?CTT=1
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The following are sample slide layouts available for use when 
building your own PowerPoint presentation:
Title slide
Title with Header Line and Footer
No title, Footer only (3 slide layouts)
Title without Line with Footer 

Sample Slide Layouts

Note, PowerPoint may display the slide layouts in reverse order 
than what is shown in the example below.

For design consistency, it is recommened that when creating 
your presentation you use the slide layouts containing Title with 
Header Line and Footer. When appropriate use (sparingly) the 
other slide layout options.

  Fermi National Accelerator Laboratory  PowerPoint Guideline (Mac)          2014

Title Slide Title & Content Content & Caption 

Footer Only: Blank Footer Only: ComparisonFooter Only: Picture & Caption

Footer Only: Title & Content

Picture & CaptionTwo Content & Caption
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The header and footer has been designed to maintain consistency 
in Fermilab’s brand and identity. 

The type size for the header title is 24pt. The type size for the footer 
information is 9pt in a regular weight. The “Presenter Name” and 

“Presentation Title” are separated by a vertical line element. 

The recommended primary typeface is Helvetica and the alternate 
typeface is Arial. 

Header and Footer

Slide number

24pt type size

Date: fixed date or auto update 
(this can be selected in the 
Header and Footer settings on 
page 6).

A vertical line element separates 
“Presenter” and “Presentation Title.” 
A single space before and after the 
vertical line is recommended. 

The light blue line with the  
Fermilab Logo is a footer design 
placed into the background and 
cannot be modified.

The light blue line is part of the 
background slide design and 
cannot be modified. The title 
of the slide should always be 
placed above the line.

There is an alternate slide 
layout available named Title 
without Line with Footer.
The title size should remain at 
24pt type even without the title 
line element.

Header

Footer
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The following are steps to edit the Footer text that appears at the 
bottom of each slide. 

Editing the Footer

Date  
2 options: update automatically or fixed.

Slide number

Footer
Type your name in place of “Presenter”  
and type in your presentation title. 
A vertical line separates the name and 
title. Leave a space before and after the 
vertical line.

Don’t show on title slide
Check this box.

Footer

Step 1.  Click on any content slide, click Insert and  
Header and Footer... 

Step 2.  The Header and Footer window will appear.  
Click on the fields to change the footer information.

Another way to open the Header and Footer window 
is to click View and then Header and Footer... 

Select any 
content slide to 
edit the footer;  
it will not work if 
the title slide is 
selected.
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A Fermilab color palette has been created and should be used 
when creating your PowerPoint presentation.

When opening your Fermilab template file, the Fermilab theme 
colors may appear in the first row under Theme Colors. To see 
the Fermilab colors, highlight the text to change color, click on the 
Font Color tab (step 1) and click More Colors (step 2).  
A new Colors window will open with the Fermilab palette (step 3).

In some cases the Fermilab colors may not appear; click on the 
CMYK/RGB slider and enter the color formulas provided on  
the right.

Colors

1. Font Color

Fermilab Palette
may also appear 
here.

2. More Colors

Clicking on this tab will 
reveal the CMYK /RGB 
sliders.

3. Colors window

PowerPoint 2011 The Fermilab colors may appear in the first row 
under Theme Colors, if this is not the case, use the 
CMYK/RGB slider window to enter Fermilab colors.

A color theme file (Fermilab.xml) is available to  
copy onto your harddrive. 

On Mac OSX save Fermilab.xml file in: 
Users/username/Library/Application Support/ 
Microsoft/Office/User Templates/My Themes

Note, the folder location may differ depending on the 
version of operating system and particular set up of 
the machine being worked on.

If you cannot access My Themes folder on your com-
puter, the other option is to enter the color formulas.

Fermilab Colors 
should appear 
here under 
Theme Colors.

Helpful site:
http://office.microsoft.com/en-us/mac-word-help/create-
and-use-your-own-template-HA102929444.aspx me-color-
HA102927281.aspx?CTT=1
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Theme Colors

Recommended for text Accent colors, use sparingly

RGB: 153,214,234
CMYK: 34,0,5,0

RGB: 175,39,47 
CMYK: 5,96,80,22

RGB: 0,181,226 
CMYK: 75,0,5,0

RGB: 76,140,43 
CMYK: 76,3,100,18

RGB: 246,141,46 
CMYK: 0,54,87,0

RGB: 167,168,170 
CMYK: 0,0,0,75

Blue (text and bold titles) 
RGB: 0,76,151 / CMYK: 100,53,2,16

Dark Gray (text)  
RGB: 99,102,106 / CMYK: 0,0,0,75
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Helvetica 32 pt 
(alternate: Arial Bold)

Helvetica 20 pt 
(alternate: Arial)

Font Sizes 

All other content slidesTitle slide

Helvetica 24 pt 

Helvetica 22 pt 
Helvetica 20 pt 

Helvetica 9 pt 
(Regular weight)

Helvetica 18 pt 

Helvetica 24 pt 
(Bold)

This section provides the recommended font sizes and weights to 
be used in your PowerPoint presentation. 

Helvetica is Fermilab’s sans serif typeface. This PowerPoint tem-
plate has been created with Helvetica. If Helvetica is not an option, 
Arial is the replacement font.

Fonts
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A Fermilab Keynote template has been created based on Fermilab’s 
brand and identity. This template file is available for use on all  
future Fermilab presentations. This file offers a clean layout, clear 
typography and appropriate color choices.

The template file is available only in the standard 4:3 format.

Keynote Guidelines
This guideline provides information that will be helpful in creating 
your presentation. Included in this guide are the following: an 
overview of slide layout designs; header and footer styles; colors; 
fonts and text styles. The examples in this guide are screenshots 
from Keynote 09. Keep in mind that Keynote will have a different 
interface and layout depending on your operating system and 
software version. 

Fermilab Keynote Template

1. Click and open the file provided that is titled  
Fermilab_KeynoteTemplate.key 
Save the template file onto your computer. It is a good  
idea to have a blank template file that you can reopen  
when starting a new presentation.

Using the Fermilab Keynote template file

This is what the file should look  
like when opened in Keynote.

Three slides are available in 
the slide thumbnail menu. 
More slide layout options 
can be selected from the  

“Add Slide” button above  
the slide thumbnails. 

Using Fermilab’s Keynote Template File
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1. Click Add Slide.
2. A window of 9 slide options 

are available for use. 
 
A description of the slide 
layout is on page 3. 
 

Selecting Fermilab Slide Layouts

The Add Slide button may be in different locations depending 
on the version of operating system and particular set up of the 
machine being worked on. 

To insert a new slide using one of Fermilab’s slide layout designs, 
locate the Add Slide button in the top left above the slide  
thumbnail menu. Thumbnails showing a variety of slide layouts 
should appear.

  Fermi National Accelerator Laboratory  Keynote Guideline                  2014



32

The following are sample slide layouts available for use when 
building your own Keynote presentation:
Title slide
Title with Header Line and Footer
No title, Footer only (3 slide layouts)
Title without Line with Footer 

Sample Slide Layouts

Title Slide Title and Content Content with Caption 

Footer Only: Blank Footer Only: Comparison Footer Only: Picture / Caption

Footer Only: Title and Content

Picture with CaptionTwo Content / Caption

For design consistency, it is recommended that when creating 
your presentation you use the slide layouts containing the Title 
with Header Line and Footer. When appropriate use (sparingly) 
the other slide layout options. 
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Header and Footer

The header and footer have been designed to maintain consistency 
in Fermilab’s brand and identity.

The type size for the header title is 24 pt. The type size for the footer 
information is 9 pt in a regular weight. The “Presenter Name” and 

“Presentation Title” are separated by a vertical line element.

The recommended primary typeface is Helvetica and the substitute 
typeface is Arial.

Slide number:
The template is 
set up to do an 
automatic slide 
count.

24 pt type size

Date: 
This date is set to the date the presenation has 
been created. To change the function of the date, 
click on this link to understand and modify footer 
content. 
http://www.freeiworktemplates.com/2011/04/how-to-
add-automatic-timestamps-in/

A vertical line element separates “Presenter” and 
“Presentation Title.” A single space before and after 
the vertical line is recommended. 

Please note that this info will need to be updated 
in the master slide edit window. If many slide lay-
outs are being used, each layout design will need 
to be editied in the master edit window. 

The light blue line with the  
Fermilab logo is a footer design 
placed into the background and 
cannot be modified.

The light blue line is part of the back-
ground slide design and cannot be 
modified. The title of the slide should 
always be placed above the line.

There is an alternate slide layout 
available that has a Footer Only with 
various text/image styles. The title 
size should remain at 24 pt type even 
without the title line element.

Header

Footer
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The page number will auto generate. The date is fixed to the date 
the presentation has been created. To modify footer contents, 
click on Edit Master Slide. To edit the Presenter | Presentation 
Title, click on the slide layout that you are using in the Edit  
Master Slide window, and edit the Presenter | Presentation Title. 
The content will update your slides on that particlular slide layout 
only. Please note, if you are using multiple slide layouts in your 
presentation, each slide layout will need to be edited. Changing 
one slide layout's content will not update all slides.
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A Fermilab color palette has been created and should be used 
when creating your Keynote presentation. The palette, a separate 
file called Fermilab.clr, will need to be installed for it to appear in 
your Keynote template file. The palette will be installed through 
Keynote. 

Once the palette has been installed, it will appear after select-
ing text, and then choosing the Text tab in the menu to the right. 
Click on the small color wheel button to open a window of the 
Fermilab color palette. 

If installation of the color palette does not work, click on the 
CMYK/RGB slider and enter the color formulas provided on  
the right.

Instructions to install the Fermilab.clr.
1. Download the file onto your desktop.
2. Open Keynote.
3. In Keynote, click on the Text tab, click on the  

color wheel button (see to the right).
4. After clicking on the color wheel button,  

click the middle color slider/grid.

Instructions to change the colors on text elements
1. In Keynote, click on the slide, highlight the type on  

the slide.
2. Click on the Text tab.
3. Click on the color wheel icon to see the Fermilab palette.
4. After clicking on the color wheel button, a window should 

open up displaying the Fermilab colors.

Colors

After clicking on  
the color wheel 
button, a 
window should 
open up  
displaying the  
Fermilab colors.

Click on the 
Text tab.

Click on the 
color wheel 
button to 
see the 
Fermilab 
palette.

Theme Colors

Recommended for text Accent colors, use sparingly

RGB: 153,214,234
CMYK: 34,0,5,0

RGB: 175,39,47 
CMYK: 5,96,80,22

RGB: 0,181,226 
CMYK: 75,0,5,0

RGB: 76,140,43 
CMYK: 76,3,100,18

RGB: 246,141,46 
CMYK: 0,54,87,0

RGB: 167,168,170 
CMYK: 0,0,0,45

Blue (text and bold titles) 
RGB: 0,76,151 / CMYK:100,53,2,16

Dark Gray (text)  
RGB: 99,102,106 / CMYK: 0,0,0,75

This is an enlargement 
to show the color menu.

Click on this color slider/grid.

Then click on this 
gear icon and click 
Open...
Locate the file on 
your desktop and 
the Fermilab 
palette should 
appear.
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1. If styles need to be reapplied or changed, 
click on Text (the middle tab) in the menu on 
the right.

2. Click on the small gray triangle to the right 
of the text style. This will show a drop down 
menu of more styles. 

Helvetica 32 pt 
Bold

Helvetica 20 pt 
Regular

Click the small 
gray triangle to 
show more styles.

Title slide

This section provides the recommended font sizes and weights 
to be used in your Keynote presentation. Helvetica is Fermilab’s 
sans serif typeface. This Keynote template has been created with 
Helvetica. If Helvetica is not an option, Arial is the substitute font.

Fonts & Text Styles

24 pt Reg
22 pt Reg
20 pt Reg

9 pt Regular

18 pt Reg

24 pt Bold

All other content slidesFont Sizes & Styles

This example is using Helvetica, although
Arial can be used as a substitute.

Using the Text Styles built into Keynote
Text styles have been created for all text elements  
on your slide layouts.

Please note: 
Do not use this Style tab. This is 
confusing as it is labeled “Style,” 
but it is not the correct one to use.
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To place an image or object onto your slide, click outside of the 
text areas on the slide, select Insert > Choose. Search for your  
file and click Insert. Drag the image to position it to fit on your 
slide layout.

After placing your image in the desired area, you can use the 
tools in the Style, Image or Arrange tabs (to the right). In these 
tabs you can mask (crop) an image, change its brightness, contrast, 
and other image qualities; or erase its background.

Placing an Image or Object
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1. Go to Insert, select Choose.
2. Locate your image and click Insert.

1. Select the image on your slide.
2. Click the Image tab on the right.
3. Click Edit Mask and make the crop that 

best fits your slide layout.

Placing an image

To crop your image

1.   Image has been placed and it is too large for the slide layout.

2.   Click on the Image tab, then click Edit Mask.

3.   The image has been cropped to fit the slide layout.

In the master slide layouts, there are a few slides that have 
placeholder images placed into the slide. These images have been 
sized and cropped to the appropriate size and within the margin. 
Images should not exceed past the footer design on the right or 
left. The right and left and top margin is .25 inches. Images should 
not go above or below the footer.

Helpful sites:
Using the mask tool to crop and compose 
images
http://support.apple.com/kb/VI117?viewlo-
cale=en_US

Keynote Tips
http://www.marrathon.com/tips/files/catego-
ry-keynote.php

Keynote Basics for Beginners
http://www.macforbeginners.com/page.
php?id=188
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Color

Identity

Paper

Typography and Fonts

Four-color process / CMYK (C) Cyan, (M) Magenta, (Y) Yellow, (K) Black. The four colors used by  
conventional offset printing presses to create images that, to the naked eye, appear to be full color.  
The printing process itself is referred to as four-color process.

Pantone Matching System / PMS a standardized system for color matching and specification.

Shade the degree of vividness of a color, as modified by the addition of black.

Tint the degree of vividness of a color, as modified by the addition of white.

Identity/ brand identity the collective aspect of characteristics (including all perceptual and emotional 
affiliations) by which an organization is definitively recognizable or known; the core meaning of an  
organization.

Brand often used interchangeably with identity and often used to refer simultaneously to both the logo 
and the identity.

Logo a name, sign or symbol used to identify an organization.

Logomark a visual symbol representing an organization that does not generally contain the name  
of the institution — it more abstractly represents that institution. It may or may not always sit next to 
the logotype.

Logotype is the name of an institution that is designed in a visually unique way for use by that company.

Clear space the area surrounding a logo in order to ensure its legibility and integrity.

Co-branding the affiliation of two or more organizational identities.

Coated paper is paper coated with a compound to produce a smoother finish on the paper, reduce  
ink absorbency and increase the sharpness of reproduction.

Uncoated paper a lack of surface coating allows the ink to be absorbed by the paper and spread.

Typeface a design for a set of characters, for example Helvetica and Palatino are typefaces.

Font an assortment or set of type or characters all of one style and one size, for example Helvetica 
Bold 12pt is a font.

Baseline the line upon which most letters sit, with the exception of certain characters that have  
descenders, such as g or p, and curved letters such as c or o which extend ever-so-slightly below.

Lining figures numerals of uniform height and width, for example 123456. This is better for use in 
tables and spreadsheets.

Old-style figures numerals that vary in height and width, for example 123456. They can extend above  
or below the baseline in a manner similar to letterforms. Good for lengthy text.

Leading describes the amount of space between two w lines of text, it is measured from baseline to 
baseline, also referred to as line-spacing.

Point the point system is the standard measurement for type, one point is equal to 1/72 inch or .35 
millimeters.
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